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1 About this manual
Welcome to IBM® Rational® DOORS® for Serena PVCS Version Manager 
Interface.
Rational DOORS for Serena PVCS Version Manager Interface transfers data 
between Rational DOORS and Serena PVCS Version Manager. It allows 
complete lifecycle traceability from requirements through to configuration 
management.
This manual describes how to use version 1.4.1 of Rational DOORS for Serena 
PVCS Version Manager Interface. It assumes that you know how to use both 
Rational DOORS and Serena PVCS Version Manager.

Typographical conventions
The following typographical conventions are used in this manual:

Related documentation
The following table describes where to find information in the documentation 
set:

Typeface or 
Symbol

Meaning

Bold Book titles, important items, and items that you can select, 
including buttons and menus. For example: Click Yes to 
continue.

Courier Commands, files, and directories; computer output. For 
example: Edit your .properties file.

> A menu choice. For example: Select File > Open. This means 
select the File menu, then select the Open command from it.

For information on See

How to use Rational DOORS The Rational DOORS documentation 
set
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These documents are on the Rational Information Center at 
http://publib.boulder.ibm.com/infocenter/rsdp/v1r0m0/index.jsp.

How to use Serena PVCS Version 
Manager

The Serena PVCS Version Manager 
documentation set 

What’s new in Rational DOORS for 
Serena PVCS Version Manager Interface 
1.4.1

The Rational DOORS for Serena PVCS 
Version Manager Interface readme file

How to install Rational DOORS for 
Serena PVCS Version Manager Interface 

Rational DOORS Installation Guide

How to set up licenses to use Rational 
DOORS for Serena PVCS Version 
Manager Interface 

Rational Lifecycle Solutions Licensing 
Guide

For information on See



Using Rational DOORS for Serena PVCS Version Manager Interface     3

2 Concepts
This chapter introduces Serena PVCS Version Manager Integration and explains 
the concepts you need to understand before using it:

• About Rational DOORS for Serena PVCS Version Manager Interface

• About Rational DOORS for Serena PVCS Version Manager Interface 
functions

About Rational DOORS for Serena PVCS Version Manager Interface
Rational DOORS is the world’s leading tool for creating, structuring and 
managing complex sets of requirements, such as those for a typical software 
development project. Serena PVCS Version Manager from MERANT Solutions, 
Inc. is a widely used source code control system.
Rational DOORS for Serena PVCS Version Manager Interface is a bridge 
between these two products, enabling complete lifecycle traceability from 
requirements through configuration management.
Rational DOORS for Serena PVCS Version Manager Interface allows software 
project teams to:

• Establish traceability from Rational DOORS information to specific files, 
folders or file revisions in Serena PVCS Version Manager.

• Import release label information from Serena PVCS Version Manager to 
Rational DOORS.

• Import promotion group information from Serena PVCS Version Manager 
to Rational DOORS.

• Create Rational DOORS baselines to match Serena PVCS Version Manager 
version labels.

• Generate complete reports on combined Serena PVCS Version Manager and 
Rational DOORS configuration status.

About Rational DOORS for Serena PVCS Version Manager Interface 
functions

Rational DOORS for Serena PVCS Version Manager Interface provides two 
functions that are fundamental to integrating configuration management with 
lifecycle traceability:
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• The ability to represent the configuration item structure stored in Serena 
PVCS Version Manager as a Rational DOORS module.

In this operation, each folder, file and revision in the selected project is 
represented by a Rational DOORS object in a hierarchy that represents the 
complete version tree for that project.

Once you have replicated the Serena PVCS Version Manager configuration 
item structure in a Rational DOORS module, you can use normal Rational 
DOORS link functions to establish traceability from project information 
stored in Rational DOORS to the configuration items.

For example, a Serena PVCS Version Manager version object that 
implements a specific requirement can be directly linked to the 
corresponding Rational DOORS requirement object. This allows you to 
demonstrate conformance to requirements at source-code level.

• The ability to baseline Rational DOORS modules using the same version 
labels as the Serena PVCS Version Manager data.

This operation uses another Rational DOORS module to store a list of 
labels that exist in each project, and to create baselines automatically for 
groups of modules. Each baseline is recorded in the Rational DOORS 
module, providing a configuration management record of which Rational 
DOORS baselines relate to which Serena PVCS Version Manager labels. 
This function also provides the ability to create baselines for many Rational 
DOORS modules simultaneously.

These two functions create a unified approach to both traceability and 
information release control, resulting in full lifecycle traceability and rigorous 
configuration management.
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3 Importing from Serena PVCS Version 
Manager

This chapter describes: 

• Importing from Serena PVCS Version Manager to Rational DOORS

• Viewing Serena PVCS Version Manager information

• Understanding imported information

• Using Rational DOORS traceability

Importing from Serena PVCS Version Manager to Rational DOORS
This operation reads the complete structure of a Serena PVCS Version Manager 
project into a Rational DOORS module, creating a Rational DOORS object for 
each folder, file and revision. Key properties, version labels and promotion 
groups are also imported.
Rational DOORS for Serena PVCS Version Manager Interface uses the Serena 
PVCS Version Manager project root to locate a project. If you want to point to a 
different project, you must change the PVCSRoot entry in your registry. You 
may need to change the value of the PVCSVersion entry to reflect the version 
of Serena PVCS Version Manager that you are using (from 6.0. to 6.7).

Importing structures
You can import into an empty module or into a module that already contains 
objects. Each Serena PVCS Version Manager project is always imported under its 
own top-level object.
Normally, you maintain your configuration item structure in a special module, 
though you might choose to store information for several projects in the same 
module. If you choose to do this, the new project is imported under a new 
level-one object at the end of the module.
To import from Serena PVCS Version Manager:
1. Open the target Rational DOORS module.

2. From the Rational DOORS menu, select Serena PVCS Version Manager 
then Synchronize/import.
The Enter PVCS Logon dialog box is displayed.
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3. Enter your username and password, then click OK.

The DOORSConnect PVCS dialog box is displayed.

4. Click the plus signs (+) to display more folders or files within a project.

5. Select the project or files you want to import, then click Import. 
One or more command prompt windows (DOS boxes) appear briefly during 
the import, depending on your version of Serena PVCS Version Manager. 
This happens when Rational DOORS for Serena PVCS Version Manager 
Interface is communicating with Serena PVCS Version Manager. The 
command prompt windows disappear automatically when the process is 
complete. 

Note  Command prompt windows will appear briefly whenever 
Rational DOORS for Serena PVCS Version Manager 
Interface communicates with Serena PVCS Version 
Manager.

When the import is complete, the import report is displayed.

This window shows how many new items were created during the import, how 
many items were updated and how many were deleted.
For information on how to use the report window functions, see “Viewing 
Serena PVCS Version Manager information,” on page 8.

Updating imported structures

It is likely that your Serena PVCS Version Manager data will continue to evolve 
after you have imported it into Rational DOORS. Rational DOORS for Serena 
PVCS Version Manager Interface can synchronize existing imported data with 
the state of the Serena PVCS Version Manager projects, adding new folders, files, 
revisions, version labels and promotion groups as required.
To do this, select the Rational DOORS module to update and repeat the 
procedure in “Importing structures,” on page 5. This object appears at the top of 
the structure, usually the first object in the module. A dialog box shows how 
many items have been created or updated.
If an item has been deleted from the project, the equivalent object in the Rational 
DOORS module has the PVM Deleted attribute set to True. The object has 
not been deleted in order to maintain correct traceability in Rational DOORS.
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Importing from Serena PVCS Version Manager to Rational DOORS

Imported attributes for structures

During the import process, Serena PVCS Version Manager data is stored as 
Rational DOORS attributes. All Serena PVCS Version Manager-related attributes 
are distinguished by a PVM prefix.
The following attributes are used to store Serena PVCS Version Manager 
properties:

Attribute Description

Object Heading The name of the Serena PVCS Version Manager folder or 
file, or the number of the revision.

Object Text The Serena PVCS Version Manager check-in comment 
for revisions.

PVM Archive Directory The directory containing the archive.

PVM Archive Name The name of the archive.

PVM Date The date on which the element, version or branch was 
created.

PVM Deleted The date on which the element, version or branch was 
deleted.

PVM Directory The directory maintained by Serena PVCS Version 
Manager that corresponds to a folder. This attribute is 
only used when importing from a Serena PVCS Version 
Manager 6.0 database.

PVM Kind Identifies the type of the object. Possible values are 
Project, Folder, File, Label and Revision.

PVM New A boolean attribute that identifies new items added by 
importing or synchronizing data.

PVM Updated The date on which the element, version or branch was 
updated.

PVM User The name of the person who created the file or revision.

PVM Work Directory The directory where the work file is stored for files, or the 
directory where work files are extracted for a folder.

PVM Work File The name of the work file.
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Rational DOORS for Serena PVCS Version Manager Interface also imports 
Serena PVCS Version Manager labels and promotion groups. These too are 
stored as Rational DOORS attributes and the values are kept with each Rational 
DOORS object. 
If you have a Serena PVCS Version Manager label Release 1, a Rational DOORS 
attribute of type Boolean called PVM Label Release 1 is created. All versions 
that are marked with that label will have the Rational DOORS attribute set to 
True. A simple Rational DOORS filter immediately shows which items belong 
to which release.
If you have a Serena PVCS Version Manager promotion group QA, a Rational 
DOORS attribute of type Boolean called PVM Promo QA is created. When a 
revision belongs to that group, the attribute is set to True.
Rational DOORS for Serena PVCS Version Manager Interface also creates three 
attributes to store import metadata: PVM Deleted, PVM New and PVM 
Updated. These are set each time you import or synchronize and are the basis 
for the import report filters. You can create your own filters and views based on 
these attributes.

Viewing Serena PVCS Version Manager information
Rational DOORS provides many useful ways of viewing imported Serena PVCS 
Version Manager information. It has the advantage of being able to put all 
relevant information into a single screen.
This is particularly useful for any updated information, which is clearly shown 
using the standard Rational DOORS change bars. After an import, new or 
updated items have their change bars set to red, but the rest of the objects 
remain unchanged. For example, in the picture above you can see that one object 
has recently been added.
In the case of a re-import, you can use the New items, Updated items and 
Deleted items buttons in the Serena PVCS Version Manager Import Report 
window to show only the items that were new, updated, or deleted.

Understanding imported information
Serena PVCS Version Manager information is imported and turned into normal 
Rational DOORS objects. This section explains how to interpret this 
information and how to get the best from it.
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Using Rational DOORS traceability

Graphics colors for structures 

When each item is imported, it is assigned a background color, used in graphics 
mode. This helps provide instant visual recognition of the structure of your data.
The color allocations are as follows:

Version labels 

Serena PVCS Version Manager version labels are typically used to mark which 
files were included in a particular release. Version labels are supplied when files 
are checked in and are a simple string such as Patch 1.1. The import process 
creates a Boolean attribute for each label prefixing the label name with PVM 
Label. For this example, the Boolean attribute would be PVM Label Patch 1.1. 
Each version that is labeled with a given name has the Rational DOORS 
attribute set to True. This can be used in filters and gives instant indications of 
what versions were used in a given release.

Using Rational DOORS traceability 
Once imported into Rational DOORS, the Serena PVCS Version Manager 
structure can be treated the same way as normal Rational DOORS objects. This 
means that they can be included in your traceability schema. A typical application 
of this is to link source code modules to requirements in order to check which 
requirements have been met.

Link management
You can use any of the following standard Rational DOORS methods for 
creating links between Serena PVCS Version Manager configuration items and 
other Rational DOORS information: 

• Drag and drop 

• Link > Create links 

Type Color

Project Black (no color on normal Rational DOORS background)

Folder Green

File Blue

Revision Light blue
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• Link module matrix 

In each case you must take the direction of each link into account to enable 
impact and traceability analyses to be performed. These analyses can be 
performed using the following standard tools: 

• Pop-up menus 

• Analysis > Impact or Analysis > Trace 

• Layout DXL 

• Analysis > Wizard 

The last item, the analysis wizard, is particularly good for creating customized 
traceability reports. With this, you could create a report that shows the 
relationship between change requests and code check-ins, showing complete 
version names in the context of the change requests.
Links can be deleted by using any of the standard techniques.

Applications of imported structures
Rational DOORS can be used to store any kind of structured information, so it 
is likely that you already have information that can be usefully linked to the 
configuration items. In addition to the classic application of requirements 
traceability, you can also build links from change requests, bug reports, design 
information, test plans and project plans to Serena PVCS Version Manager 
versions.
Once in place, you can demonstrate that specific changes have been 
implemented, or create reports that justify all checked-in changes.
Another application is to create complete product manifests. Using the Rational 
DOORS export functions, you can create documents in Microsoft Word, HTML 
or any other supported format, that lists the document version included in a 
shipment.
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4 Labelling Rational DOORS baselines 
This chapter describes: 

• Importing Serena PVCS Version Manager labels into Rational DOORS

• Creating Rational DOORS baselines

• Understanding baseline information

• Using Rational DOORS traceability

Importing Serena PVCS Version Manager labels into Rational DOORS 
Serena PVCS Version Manager labels are typically used to mark which files were 
included in a particular release. Version labels are specified when revisions of 
files are checked in. 
Rational DOORS baselines create frozen versions of modules that are similar to 
checked-in versions of files: they can be referenced, but not changed. Baselines 
are numbered progressively using major and minor versions, plus an optional 
text suffix. 
Serena PVCS Version Manager version labels are ideal for Rational DOORS 
baseline suffixes, where they can be used for the same purpose as in Serena 
PVCS Version Manager. 
Baseline labelling is a two-step process: importing labels from a project module 
and creating baselines. The import process sets up a structure where a record of 
each baseline is kept. This section describes the import step while “Creating 
Rational DOORS baselines,” on page 13 describes baseline creation. 

Importing labels 

You can choose to import version labels into an empty module or into a module 
that already contains objects. The set of labels from each project is always 
imported under its own top-level object. 
Normally you should maintain your label and baseline structure in a special 
module, though you might choose to store label information for several projects 
in the same module. If you choose to do this, the new project will be imported 
under a new level-one object at the end of the module. 
Before using the baseline labelling process you must import the required Serena 
PVCS Version Manager project into a Rational DOORS module. The baseline 
process reads the version labels from this module. 
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Note  You must be a Rational DOORS database manager to 
perform this function. It performs irrevocable module 
baseline operations. 

To import labels: 
1. Open your target Rational DOORS module. If the module is not empty, 

select a parent object for your imported structure. 

2. From the Rational DOORS menu, select Serena PVCS Version Manager 
then Label baselines. 

A DOORSConnect PVCS dialog box is displayed.

3. Select the Rational DOORS module previously used to import the Serena 
PVCS Version Manager project.

A dialog box is displayed, with one or more projects in the select box.

4. Select the project whose labels you want to use.

5. Click Use project to create the module structure. 

When the import is complete, the Rational DOORS module is updated and 
the Apply Label to Modules window appears. For further information, see 
“Creating Rational DOORS baselines,” on page 13. 

Re-importing labels 
After you have completed this baseline labelling operation, you may want more 
Serena PVCS Version Manager labels. Rational DOORS for Serena PVCS 
Version Manager Interface can synchronize existing imported labels with the 
Serena PVCS Version Manager project, adding new labels as required.
To do this, after selecting the project object at the top of the label and baseline 
structure, repeat the procedure in “Importing labels,” on page 11.

Imported attributes for labels 

During the import process, Serena PVCS Version Manager data is stored as 
Rational DOORS attributes. All Serena PVCS Version Manager-related attributes 
are distinguished by a PVM prefix. 
The following attributes are used to store Serena PVCS Version Manager 
properties:

Attribute Description

Object Heading The name of the Serena PVCS Version Manager label.
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Creating Rational DOORS baselines

Creating Rational DOORS baselines
Creating Rational DOORS baselines is the second step of the import process. 
Baselines are created using a DOORSConnect PVCS dialog box, which is 
displayed when the import is complete.
To create labeled baselines:
1. Ensure that all needed Rational DOORS modules are closed and not in use 

by anyone else. 

2. Select the required label from the list in Serena PVCS Version Manager 
version labels. 

3. Select the required module(s) from the list in Rational DOORS modules. 
Use Select all and Clear all to simplify the selection process. 

4. Select the type of baseline required: Suffix only, Minor version, or Major 
version. 

5. Select whether to include a suffix by clicking Use suffix. The default suffix 
is the selected Serena PVCS Version Manager label. You can modify it if 
required. 

6. Modify the label comment, if necessary. It is used as annotation for the 
baseline. 

7. Click Baseline. You are asked to confirm the operation, twice. Baseline 
creation requires exclusive, write access to all selected modules. This means 
you must ensure that no one else is using the modules. 

Once a baseline has been created it cannot be destroyed or recreated, so you 
must be absolutely certain that a group baselining operation is correct before 
proceeding.

Object Text The Serena PVCS Version Manager comment for the 
label, specified when the label was created.

PVM Kind Identifies the type of the object. Possible values are 
Project, Label and Baseline.

PVM User The name of the person who created the label.

PVM Date The date on which the label was created. 

Attribute Description
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Baselines are created for each of the specified modules, and the label module is 
updated to contain a baseline-creation object for each module. 
The attribute PVM Baseline is created and filled with the baseline name for 
each baseline-creation object. 
When complete, a dialog box is displayed, indicating how many labels and 
baselines were created.
For further information on how to use the window functions, see 
“Understanding baseline information,” on page 14.

Understanding baseline information
All the normal Rational DOORS viewing mechanisms can be used on the label 
and baseline structure. The information can be displayed in either document or 
graphics mode. Each object type has a color to aid visual identification.

Graphics colors for labels 

When each item is imported, it is assigned a background color that is used in 
graphics mode. This helps provide instant visual recognition of the structure of 
your data. 
The color allocations are as follows:

Viewing new baseline information
If you re-import labels or create new labels in the same module, you can use the 
Baseline Labelling Report window’s Apply filter button to show only the 
newly-created items.
A DOORSConnect PVCS dialog box is displayed.
Click Apply filter.
The formal module is displayed with the filter applied.

Type Color

Project Black (no color on normal Rational DOORS background)

Label Red

Baseline Blue
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Using Rational DOORS traceability

Using Rational DOORS traceability 
By storing information on labels and baselines in a Rational DOORS module, 
they can be included in your traceability schema. In this way you can link details 
of released information directly to project plans and other applications, as 
outlined below. 

Link management for labels 
You can use any of the following standard Rational DOORS methods for 
creating links between label and baseline objects and other Rational DOORS 
information:

• Drag and drop

• Link > Create links
• Link module matrix

In each case, you must take into account the direction of links to allow impact 
and traceability analyses to be performed as required. These analyses can be 
performed using the following standard tools:

• Pop-up menus

• Analysis > Impact or Analysis > Trace
• Layout DXL

• Analysis > Wizard
The last item, the analysis wizard, is particularly good for creating customized 
traceability reports. With this, you could create a report that shows the 
relationship between code check-ins and module baselines, showing complete 
version names, baseline specifications and dates in the context of planning 
information.
Links can be deleted using any of the standard techniques.

Applications of imported labels 
Rational DOORS can be used to store any kind of structured information, so it 
is likely that you already have information in your data that can be linked to 
baseline records. You might associate particular module baselines with deliveries 
made to customers, meeting specific requirements.
Another application is to create complete product manifests. Using the Rational 
DOORS export functions, you can create documents in Microsoft Word, HTML 
or any other supported format, that lists the document version included in a 
shipment.
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5 Contacting support
This chapter contains the following topics:

• Contacting IBM Rational Software Support

• Prerequisites

• Submitting problems

• Other information

Contacting IBM Rational Software Support
If the self-help resources have not provided a resolution to your problem, you 
can contact IBM Rational Software Support for assistance in resolving product 
issues.

Note  If you are a heritage Telelogic customer, you can go to 
http://support.telelogic.com/toolbar and download the 
IBM Rational Telelogic Software Support browser toolbar. 
This toolbar helps simplify the transition to the IBM Rational 
Telelogic product online resources. Also, a single reference 
site for all IBM Rational Telelogic support resources is 
located at 
http://www.ibm.com/software/rational/support/telelogic/

Prerequisites
To submit your problem to IBM Rational Software Support, you must have an 
active Passport Advantage® software maintenance agreement. Passport 
Advantage is the IBM comprehensive software licensing and software 
maintenance (product upgrades and technical support) offering. You can enroll 
online in Passport Advantage from 
http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html.

• To learn more about Passport Advantage, visit the Passport Advantage 
FAQs at 
http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_
quickguides.html.

• For further assistance, contact your IBM representative.

To submit your problem online (from the IBM Web site) to IBM Rational 
Software Support, you must additionally:
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• Be a registered user on the IBM Rational Software Support Web site. For 
details about registering, go to 
http://www-01.ibm.com/software/support/.

• Be listed as an authorized caller in the service request tool.

Submitting problems
To submit your problem to IBM Rational Software Support:

1. Determine the business impact of your problem. When you report a 
problem to IBM, you are asked to supply a severity level. Therefore, you 
need to understand and assess the business impact of the problem that you 
are reporting.

Use the following table to determine the severity level.

2. Describe your problem and gather background information, When 
describing a problem to IBM, be as specific as possible. Include all relevant 
background information so that IBM Rational Software Support specialists 
can help you solve the problem efficiently. To save time, know the answers 
to these questions:

• What software versions were you running when the problem occurred?

To determine the exact product name and version, use the option 
applicable to you: 

Severity Description

1 The problem has a critical business impact: You are unable to 
use the program, resulting in a critical impact on operations. 
This condition requires an immediate solution.

2 This problem has a significant business impact: The program 
is usable, but it is severely limited.

3 The problem has some business impact: The program is 
usable, but less significant features (not critical to 
operations) are unavailable.

 4 The problem has minimal business impact: The problem 
causes little impact on operations or a reasonable 
circumvention to the problem was implemented.
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Submitting problems

• Start the IBM Installation Manager and click File > View Installed 
Packages. Expand a package group and select a package to see the 
package name and version number. 

• Start your product, and click Help > About to see the offering 
name and version number. 

• What is your operating system and version number (including any 
service packs or patches)? 

• Do you have logs, traces, and messages that are related to the problem 
symptoms? 

• Can you recreate the problem? If so, what steps do you perform to 
recreate the problem? 

• Did you make any changes to the system? For example, did you make 
changes to the hardware, operating system, networking software, or 
other system components? 

• Are you currently using a workaround for the problem? If so, be 
prepared to describe the workaround when you report the problem.

3. Submit your problem to IBM Rational Software Support. You can submit 
your problem to IBM Rational Software Support in the following ways:

• Online: Go to the IBM Rational Software Support Web site at 
https://www.ibm.com/software/rational/support/ and in the Rational 
support task navigator, click Open Service Request. Select the 
electronic problem reporting tool, and open a Problem Management 
Record (PMR), describing the problem accurately in your own words.

For more information about opening a service request, go to 
http://www.ibm.com/software/support/help.html

You can also open an online service request using the IBM Support 
Assistant. For more information, go to 
http://www-01.ibm.com/software/support/isa/faq.html.

• By phone: For the phone number to call in your country or region, go 
to the IBM directory of worldwide contacts at 
http://www.ibm.com/planetwide/ and click the name of your country 
or geographic region. 

• Through your IBM Representative: If you cannot access IBM 
Rational Software Support online or by phone, contact your IBM 
Representative. If necessary, your IBM Representative can open a 
service request for you. You can find complete contact information for 
each country at http://www.ibm.com/planetwide/.
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If the problem you submit is for a software defect or for missing or inaccurate 
documentation, IBM Rational Software Support creates an Authorized Program 
Analysis Report (APAR). The APAR describes the problem in detail. Whenever 
possible, IBM Rational Software Support provides a workaround that you can 
implement until the APAR is resolved and a fix is delivered. IBM publishes 
resolved APARs on the IBM Rational Software Support Web site daily, so that 
other users who experience the same problem can benefit from the same 
resolution.

Other information
For Rational software product news, events, and other information, visit the 
IBM Rational Software Web site on http://www.ibm.com/software/rational/.
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6 Notices
© Copyright IBM Corporation 1993, 2009
US Government Users Restricted Rights - Use, duplication, or disclosure 
restricted by GSA ADP Schedule Contract with IBM Corp.
This information was developed for products and services offered in the U.S.A. 
IBM may not offer the products, services, or features discussed in this document 
in other countries. Consult your local IBM representative for information on the 
products and services currently available in your area. Any reference to an IBM 
product, program, or service is not intended to state or imply that only that IBM 
product, program, or service may be used. Any functionally equivalent product, 
program, or service that does not infringe any IBM intellectual property right 
may be used instead. However, it is the user’s responsibility to evaluate and verify 
the operation of any non-IBM product, program, or service. 
IBM may have patents or pending patent applications covering subject matter 
described in this document. The furnishing of this document does not grant you 
any license to these patents. You can send written license inquiries to:  
 
IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY 10504-1785 
U.S.A.  
 
For license inquiries regarding double-byte character set (DBCS) information, 
contact the IBM Intellectual Property Department in your country or send 
written inquiries to:  
 
IBM World Trade Asia Corporation 
Licensing 
2-31 Roppongi 3-chome, Minato-ku 
Tokyo 106-0032, Japan  
 
The following paragraph does not apply to the United Kingdom or any 
other country where such provisions are inconsistent with local law: 
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES 
THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
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THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
Some states do not allow disclaimer of express or implied warranties in certain 
transactions. Therefore, this statement may not apply to you. 
This information could include technical inaccuracies or typographical errors. 
Changes are periodically made to the information herein; these changes will be 
incorporated in new editions of the publication. IBM may make improvements 
and/or changes in the product(s) and/or the program(s) described in this 
publication at any time without notice. 
Any references in this information to non-IBM Web sites are provided for 
convenience only and do not in any manner serve as an endorsement of those 
Web sites. The materials at those Web sites are not part of the materials for this 
IBM product and use of those Web sites is at your own risk. 
IBM may use or distribute any of the information you supply in any way it 
believes appropriate without incurring any obligation to you. 
Licensees of this program who wish to have information about it for the 
purpose of enabling: (i) the exchange of information between independently 
created programs and other programs (including this one) and (ii) the mutual use 
of the information which has been exchanged, should contact:  
 
Intellectual Property Dept. for Rational Software 
IBM Corporation 
1 Rogers Street 
Cambridge, Massachusetts 02142 
U.S.A. 
 
Such information may be available, subject to appropriate terms and conditions, 
including in some cases, payment of a fee. 
The licensed program described in this document and all licensed material 
available for it are provided by IBM under terms of the IBM Customer 
Agreement, IBM International Program License Agreement or any equivalent 
agreement between us. 
Any performance data contained herein was determined in a controlled 
environment. Therefore, the results obtained in other operating environments 
may vary significantly. Some measurements may have been made on 
development-level systems and there is no guarantee that these measurements 
will be the same on generally available systems. Furthermore, some 
measurements may have been estimated through extrapolation. Actual results 
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Trademarks

may vary. Users of this document should verify the applicable data for their 
specific environment. 
Information concerning non-IBM products was obtained from the suppliers of 
those products, their published announcements or other publicly available 
sources. IBM has not tested those products and cannot confirm the accuracy of 
performance, compatibility or any other claims related to non-IBM products. 
Questions on the capabilities of non-IBM products should be addressed to the 
suppliers of those products.
This information contains examples of data and reports used in daily business 
operations. To illustrate them as completely as possible, the examples include the 
names of individuals, companies, brands, and products. All of these names are 
fictitious and any similarity to the names and addresses used by an actual 
business enterprise is entirely coincidental. 
If you are viewing this information softcopy, the photographs and color 
illustrations may not appear. 
Additional legal notices are described in the legal_information.html file that is 
included in your software installation.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of 
International Business Machines Corp., registered in many jurisdictions 
worldwide. Other product and service names might be trademarks of IBM or 
other companies. A current list of IBM trademarks is available on the Web at 
www.ibm.com/legal/copytrade.html.
Microsoft and Windows are trademarks of Microsoft Corporation in the United 
States, other countries, or both.
Other company, product or service names may be trademarks or service marks 
of others.
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